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2.1 Tethered Remote Control
The Tethered Remote Control has a 20 X 4 character display at the top of the unit
(see Figure 2-1). Power on/off for the tethered remote is toggled by pressing both
power buttons simultaneously. For other key variations, refer to Table 2-1. The
Tethered Remote comes with a 25’ cable. Optional 50’ or 75’ cables are also
available (disable backlight when using 75’ cable).

Figure 2-1 Tethered Remote Control
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Table 2-1 Tethered Remote Control Key Functions

Key Function Usage

ON, OFF Press both POWER buttons to turn
projector power ON. Press both
POWER buttons again to turn
projector power OFF to turn power
off.

MODE Toggles through convergence
modes (X/Y Convergence,
Threshold and Sensitivity).

HIDE Mutes video.

CURS SIZE Select Convergence cursor size.
NOTE:  Convergence data from
smaller cursor is lost when larger
cursor size is selected.

Press CURS SIZE +
direction arrows to
toggle through
available cursor sizes.

CONV Convergence data key. Change
cursor position or display
convergence data.

Press key to enter
Position mode. Press
key again to enter
Data display mode.

PHASE Horizontal and vertical Phase
adjustment of the input image on
the CRT raster.

Press PHASE +
Left/Right arrow keys
to set phase.

BLANK Blanking.  Adjusts blanking levels at
image edges.

Press BLNK + arrow
keys to alter blanking
position.  Each press
of BLNK key changes
the active edge (top,
bottom, left, right).

POS Position.  Adjusts image raster
horizontally and vertically on the
screen.

Press POS +
Left/Right or
Up/Down arrow keys
to adjust raster
horizontal and vertical
position on screen.

SIZE Adjusts projected image height and
width on screen.

Press SIZE +
direction arrows to
adjust picture height
and width.
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Key Function Usage

KEY Keystone.  Horizontal and vertical
keystone correction for grid line
distortion at the sides or top and
bottom of an image with respect to
the center line.

Press KEY +
Left/Right or
Up/Down arrow keys
to correct for
horizontal and vertical
keystoning.

PIN Pincushion.  Vertical and horizontal
pincushion correction for distortion
at the sides or top and bottom of an
image.

Press PIN + direction
arrows to correct
both vertical and
horizontal pincushion
distortion.

LIN Linearity.  Horizontal linearity
correction for improper horizontal
grid spacing on an image.

Press LIN +
Left/Right direction
arrows to correct for
horizontal linearity
distortion.

EDGE Edge Linearity.  Horizontal edge
linearity correction for improper
grid spacing at the sides of an
image.

Press EDGE +
Left/Right direction
arrows to correct for
edge linearity
distortion.

PATTERN Displays test pattern selection
menu.

Press TEST +
Number of test
pattern to select.

BRT Brightness.  Adjust the brightness
level until the black portions of a
projected image are black, but detail
in color balanced areas is not lost.

Press BRT +
Up/Down direction
arrows to set
brightness level.

CONT Contrast.  Change the amount of
image intensity.  If image
defocusing or loss of detail occurs,
decrease either contrast or
brightness, or both.

Press CONT +
Up/Down direction
arrows to set contrast
level.

COLOR Controls the color intensity of the
video image.  If the image appears
too pale or weak, increase color
level.  If flushed or too bright,
decrease color level.

Press COLOR +
Up/Down direction
arrows to set color
level. Active only
when the input is
Composite or S-
Video.
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Key Function Usage

TINT Controls the hue of the video image.
If facial tones or objects appear too
green, increase tint.  If too purple,
decrease tint.

Press TINT +
Up/Down direction
arrows to set tint
level. Active only
when the input is
Composite or S-
Video.

SHARP Sharpness.  Controls the sharpness
of the video picture.  If the image
appears soft, increase sharpness.  If
grainy, decrease sharpness.

Press SHARP +
Up/Down direction
arrows to set
sharpness level.
Active only when the
input in Composite or
S- Video.

DEFLT Default.  Returns all picture control
to technician-set default values.

ESC Cancels last command and retreats
one menu level.

NUMBER
KEYS

Selects channel. makes Menu
selections.

CUTOFF Cuts off color channel, one color at
a time.  To cut off all three colors,
use HIDE/MODE

Press CUTOFF + R,
B, or G.

RED/GREEN/
BLUE

Color channel selection. If color is cut off,
press CUTOFF and
color key.

ARROWS Used for increasing and decreasing
control levels, cursor movement,
and convergence adjustments.

MENU Toggles on/off Main Menu display. Press once to display
Main Menu, second
time to hide Main
Menu.

ONSCRN Toggles on/off the "on screen"
information display.

ENTER Implements commands.

BOW Not available
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Key Function Usage

SKEW Not available

2.2 Keyboard Command Equivalents
The ILA-12K can be controlled by a VT-100 terminal or PC using Windows® 3.1.
Table 2-2 shows keyboard equivalents. Access Windows® Program Manager and
select Terminal, then Settings. Select Terminal Emulation, DEC VT-100(ANSI).
Use a Null Modem cable to connect the projector to the terminal. See Appendix A
for more details.

Table 2-2  Keyboard Command Equivalents

Action
Keyboard

Input
Tethered
Remote

Hex Code

Power on/off CTRL-P Both POWER
keys

10

Electronics power only CTRL + E 05

Arc lamp power only CTRL + L 0C

Power ON CTRL + U 15

Power OFF CTRL + F 06

Video mute V HIDE/MODE 56

Convergence mode D POS/CONV 44

Change channel Channel # +
ENTER*

Channel # +
ENTER

30-39 +OD

Cursor size M CURSSIZE 4D

Phase H PHASE 48

Blanking Z BLNK 5A

Position P POS 50

Size S SIZE 53

Keystone K KEY 4B

Pincushion N PIN 4E

Linearity L LIN 4C

Edge linearity E EDGE 45

Test pattern T TEST 54
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Action
Keyboard

Input
Tethered
Remote

Hex Code

Brightness I BRT 49

Contrast C CONT 43

Color A COLOR 41

Tint U TINT 55

Sharpness X SHARP 58

Picture setting defaults CTRL+D DEFLT 04

Back out of menu ESC ESC 1B

Hide R, G or B F CUT OFF 46

Red, green, blue
selection

R, G, B R,G,B
R=52
G=47
B=42

Up arrow UP Arrow UP Arrow 1B,5B, 41**

Down arrow DOWN Arrow DOWN Arrow 1B,5B, 42**

Right arrow RIGHT Arrow RIGHT Arrow 1B,5B, 43**

Left arrow LEFT Arrow LEFT Arrow 1B,5B, 44**

Access main menu SPACEBAR MENU 20

Screen display on/off O ON SCRN

*For channels with two numbers, pressing ENTER is not necessary.

**The arrow keys are a sequence of Escape, Left Bracket, and A,B,C, or D
depending on the arrow key pressed. The first number represents the Escape key,
the second number the left bracket, and the third number represents the letter
corresponding to the Arrow key pressed.



Chapter 2---Operation

ILA-12K User’s Manual 2-7

2.3 Menu Structure
The Menu Structure is multi-level and allows access to commands for checking
out and operating the ILA-12K.

To display the Main Menu, press MENU on the Tethered Remote Control or press
the SPACEBAR on a computer terminal. If the Main Menu does not display on the
projector screen, press ONSCRN to enable the On-screen command (the menus
will always display on the computer terminal screen).

NOTE: If another menu is already displayed on the screen, press ESC until the
Main Menu appears.) The Main Menu is displayed on the terminal monitor and on
the projected screen image. If using a computer terminal to run the ILA-12K, use a
terminal emulation program such as ProComm Plus® or Windows® terminal

Menu screens will remain active for 30 seconds.The menu then "times out" and is
cleared from the screen. To issue a command, access the Menu (press MENU) and
type the selection number or use the arrow keys to highlight the desired number,
and press ENTER.

Figure 2-2 shows the Main Menu Structure and the sub-menus. Section 2.4
provides a description of each menu item.
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Main Menu (Software version 5.3.0)

MAIN MENU

1. CHANNEL MENU >
2. STATUS MENU 
3. ILA MENU >
4. DIAGNOSTIC MENU >
5. TIMING MENU >
6. VIDEO QUICKSET >
7. VIDEO SHARPNESS >
8. GAMMA PROFILE >
9. AUTO-SETUP >

CHANNEL MENU

1. CHANNEL LIST
2. AUTO-SELECT LIST
3. COPY CHANNEL
4. UPDATE DEFAULTS
5. COPY PARAMETERS >
6. IMPORT/EXPORT >
8. SOURCE DECODER (OPTION) >

ILA BIAS

1. ADJUST WITH VIDEO
2. ADJUST, NO VIDEO
3. MAX-ON, NO VIDEO
4. FREQUENCY ADJUST
5. MAX-ON WITH VIDEO

TIMING SETUP 

1. PINCUSHION POSN.
2. MENU POSITION
3. 2H SYNC ENABLE
4. SHIFT SYNC
5. FRONT/REAR SET
6. SHOW DFBD OLD/NEW

VIDEO QUICKSET

1. 100% SENSITIVITY
2. 80% SENSITIVITY
3. 20% THRESHOLD
4. BIAS, NO VIDEO
5. VIDEO SENSITIVITY
6. VIDEO THRESHOLD 

DIAGNOSTIC 

1. TIMERS
2. TIMING CORRECTN
3. CENTER RASTER
5. MODEL TYPE

AUTO SETUP

1. CAMERA SETUP >
2. CENTER BALANCE >
3. SHADE >

VIDEO SHARPNESS

1. WHITE DETAIL
2. BLACK DETAIL

GAMMA PROFILE

1. FACTORY PRESET
2. TILT ADJUST

STATUS MENU

CH.NAME
34 KHZ
30.5H
YES/NO
INT/EXT
     0
ON/OFF
ON/OFF
5.3.0
2.0.5

1.  CHNL
2.  HORZ RATE
3.  FRAM RATE
4.  INTERLACE
5.  SYNC
6.  PROJ ADRS
7.  SHOW TEXT
8.  SHOW ERR
9.  CPU SW
10.DSP SW

Figure 2-2  Main Menu Structure for the ILA-12K
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Channel Menu

CHANNEL MENU

1. CHANNEL LIST
2. AUTO-SELECT LIST
3. COPY CHANNEL
4. UPDATE DEFAULTS
5. COPY PARAMETERS >
6. IMPORT/EXPORT >
7. SOURCE DECODER (OPTION) >

COPY PARAMETERS

1. X, Y, CONVERGENCE
2. SHADE & PROPORTNS
3. PROPORTION VALUES
4. SHADE, NO PROPTNS
5. ILA BIAS & FREQ
6. GEOMETRY SETTINGS
7. DEFAULT SETTINGS

IMPORT/EXPORT

1. EXPORT A CHANNEL
2. IMPORT A CHANNEL
3. EXPORT MULT CHNLS
4. IMPORT MULT CHNLS

AUTOSELECT LIST

AUTOSELECT   IS    ON
GROUP  1-10
CHANNELS 1-10     HCNT      FRAM   I

SOURCE DECODER
This Menu will depend on
which type source is selected
on the CHANNEL LIST 
INPUT (IN) Column, either 
an RGB type source or a 
UDP type source.
When an RGB (RGB 1, RGB 2)
type source will return
SELECT STANDARD
  NTSC-M
  NTSC-4.43
  PAL-(BDGI)
  PAL-M
  SECAM
etc. 
Consult the UDP User’s Guide
for Menu items.
  

CHANNEL LIST

IN
RGB1
RGB1
PC1
VTR
422

ST
ST

CL
ST
ST
BP
BP
LD

NAME
INIT

CHAN
    1.
    2.
 > 3.
    4. V
    5.

  29.
  30.

Figure 2-3  Channel Menu and submenus
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2.4 Menu Item Definitions
This section defines the menu items available through the Main Menu and
submenus.

Main Menu
CHANNEL MENU - This displays the Channel Menu.

STATUS MENU---Displays various parameters of the projector, including the
horizontal scan frequency (HORZ RATE), the vertical frequency (FRAM
RATE), if the video signal is interlaced or non-interlaced. It also displays the
current version of System Software (CPU SW), and Digital Signal Processor
Software (DSP SW).

ILA® MENU---This displays ILA® device Bias Menu.

DIAGNOSTIC MENU---This displays the Diagnostic Menu, which provides
access to timing controls. These controls should be used only by trained and
certified technicians. The Diagnostic Menu contains a hidden item - #5 Model
Type (no item #4). Model Type accesses a menu that allows the user to select
the type of projector.

TIMING MENU---This displays the Timing Setup Menu. The functions in the
TIMING MENU control the timing for the horizontal scan frequency.

VIDEO QUICKSET---This menu provides the technician with quick access to
functions used to set up Color Temperature and Gamma Curve during initial
setup. It may be used to make minor touch ups to the Gamma Curve or Color
Temperature as necessary. Each of these functions may be accessed from their
separate commands in other menus.

VIDEO SHARPNESS---This function provides enhancement for black or white
video details when needed for high definition video.

GAMMA PROFILE---This function provides adjustment of the dark levels of each
color on the Gamma Curve.

AUTO-SETUP---This item accesses a meun that uses the functions of the Auto-
Setup Tool (AST). The use of the functions on this menu require the AST be
installed on the projector. The use of this tool requires special training for
users.



Chapter 2---Operation

ILA-12K User’s Manual 2-11

Channel Menu
CHANNEL LIST---This Menu item displays the status of all active channels. The

information includes the Channel number, type of input signal, type of DC
Restore, and Channel name set by the user.

CH  =  channel number (an arrow in front of the channel number
indicates the channel is active

IN =  input (RGB1, RGB2, Video, S-Video)

SL =  (BP:backporch, ST:sync-tip, TL:Tri-level)

NAME =  user-set channel name.

AUTOSELECT LIST---This function displays the current status of the
AUTOSELECT function and allows operator to set up an AUTOSELECT
group (see section on Autoselect).

COPY CHANNEL---This function copies setup and Convergence data from
current channel to another channel. This provides a baseling setup for setting
up additional channels for multiple sources. It is important to realize that
timing requirements for different horizontal and vertical scan frequencies  will
require additional adjustment for Convergence, XY Registration, Shading.

UPDATE DEFAULTS---This function saves Picture settings to the Technician
remote values. On recent versions of System Software, this function is
performed automatically when changing channels of powering OFF the
projector.

IMPORT/EXPORT---This function imports setup data from a computer to the
projector or exports setup from the projector to a computer. This may be done
for a single channel or multiple channels. This function is very important when
servicing the projector. It is recommended to export setup data to a computer
after setting up the projector. (see Appendix A).

COPY PARAMETERS---This function allows user to copy any of seven setup
parameters selectable from the submenu.

SOURCE DECODER---This function displays the optional Decoder Setup Menu
for either RGB or UDP type video inputs depending on the INPUT type
selected in the CHANNEL LIST.

q SELECT RGB STANDARD

NTSC-M,

PAL-BDGI,

PAL-N, SECAM,

PAL-M, PAL-4.43,

NTSC-M,

NTSC-4.43,

BLK/WHT.
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Refer to the UDP User’s Guide for UDP type STANDARDS. The remainder
of the items in this menu should be used by trained and certified technicians.

Status Menu
CH. ##--This function displays the current channel number and channel name.

HORZ RATE.--This function displays the horizontal scan frequency of input
signal. +/-5% accuracy.

FRAM RATE--This function displays the vertical scan frequency of an input signal
if non-interlaced, or 1/2 the vertical scan frequency if interlaced.

INTERLACE--- This indicates whether the input video is interlaced or non-
interlaced. If not, projected image is progressive scan.

SYNC---This function indicates whether the internal or external sync is active.

PROJ. ADRS.--- This function is not applicable to the ILA-12K projector.

SHOW ADD.---This toggles adjustment data display on/off screen.

SHOW ERR.---This toggles on/off the display of error codes on-screen.

CPU SW---This displays the CPU (System) Software version. It uses two Eprom
IC chips.

DSP SW---This displays the Digital Signal Processing Software version. It uses
three Eproms.

ILA® device Bias Menu
ADJUST WITH VIDEO---This function allows the user to set the ILA® device

bias with video on the screen.

ADJUST NO VIDEO--- This function allows the user to set ILA® device bias with
video cut off.

MAX-ON NO VIDEO--- This function sets the RGB ILA® device biases to
maximum (255) without video for easier projector positioning and lateral lens
adjustment. It resets to original setting after pressing any key.

FREQUENCY ADJUST--- This function allows the user to set the ILA® bias
frequency with video on screen. A frequency of 1.8 kHz is acceptable for
general video viewing. A lower frequency provides a brighter image with lower
image burn-in. A higher bias frequency results in higher resolution. For HDTV
a frequency of 2.0-2.5 kHz provides higher resolution with less image lag.

MAX-ON WITH VIDEO---This function displays the maximum (255) ILA® bias
setting with video on screen. It resets to original setting after pressing any key.

Video Quickset
100% SENSITIVITY---This function allows the user to measure maximum light

output with video for calculations to determine Color Temperature and
Gamma Curve. It selects the STATIC FLAT FIELD Test Pattern.
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80% SENSITIVITY--- This function automatically selects the ADJUST FLAT
FIELD test pattern and sets the video output level at 80%. It accesses the
Sensitivity Offset where the user may adjust for setting Color Temperature and
Gamma Curve.

20% THRESHOLD--- This function automatically selects the ADJUST FLAT
FIELD test pattern and sets the video output level at 20%. It accesses the
Threshold Offset where the user may adjust for setting Color Temperature and
Gamma Curve.

VIDEO SENSITIVITY---This function is used to adjust Sensitivity Offset or
Proportional Offset with video or any test pattern on the screen. The user
selects External video or any Test Pattern, then selects Video Sensitivity.  Then
the color is selected and adjusted and using arrow keys to increase or decrease
Offset or Proportional. The user can select this function with the External
video on-screen, after all shading adjustments have been made, to perform
minor shading touch-up if some incorrect coloration still exists in the video.
The up/down arrow keys are used to increase or decrease any color.

VIDEO THRESHOLD---Same as #4 for Sensitivity.

Timing Setup Menu
PINCUSHION POSN---This function centers pincushion correction to image.

MENU POSITION---This function centers position of menus on the screen. It also
centers Convergence and Shading correction position.

2H SYNC ENABLE---This function is used to eliminate “flagwaving” (a video
anomoly) seen at the top of the screen.

SHIFT SYNC---This function is used to eliminate unstable images due to unusual
input sync from the source.
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X-Y- REG AXIS MENU

1. OFFSET THIS AXIS
2. CLEAR THIS AXIS
3. CLEAR CONVG AXES
4. CLEAR ALL AXES
5. SEE X AXIS VALUES
6. SEE Y AXIS VALUES

SHADE AXIS MENU

1. OFFSET THIS AXIS
2. CLEAR THIS AXIS
3. CLEAR SHADE AXES
4. PROPTN THIS AXIS
5. INIT THIS PROPTN
6. INIT ALL PROPTN
7. SEE AXIS VALUES

TEST PATTERN MENU

1. EXTERNAL VIDEO
2. WHITE X-HATCH
3. RGB X-HATCH
4. DOT PATTERN
5. PLUGE
6. STATIC FLAT-FIELD
7. ADJUST FLAT-FIELD
8. H-GRID
9. GREY SCALE
0. CONTRAST/BRIGHTNESS

Figure 2-4  Test Pattern, X- Y- Registration Axes, and Shade Axis Menus.

Test Pattern Menu
To select a test pattern with the remote, press TEST (on the Tethered Remote
Control), followed by the Test Pattern number. On a keyboard, press T and the
Test Pattern number.

EXTERNAL VIDEO---This displays the incoming source video and may be used
while adjusting PHASE, SIZE, POSITION and BLANKING.

WHITE-X-HATCH--- This displays white intersecting (cross-hatch) lines with no
background. It may be used while adjusting Convergence, Keystone,
Pincushion, Pincushion Position, and Linearity.

RGB-X-HATCH--- This displays red, green, blue or a combination of colored
intersecting (cross-hatch) lines, depending on which colors are cutoff, with no
background. It is used for Convergence final adjustments.

DOT PATTERN---Used to verify G2 setting for RGB.

PLUGE---Used to set Black/White scale.

STATIC FLAT FIELD---This displays a flat-field at 100% video level. It is used
to evaluate Sensitivity and Arc Lamp rolloff.



Chapter 2---Operation

ILA-12K User’s Manual 2-15

Sensitivity Shading adjustments.

H-GRID---This displays a screen filled with red, green, or blue uppercase H’s. It is

may also be used to focus  the Projection Lens.

GREY SCALE---This displays a series of eight stripes of incremented levels of

may be used for checking Color Balance, G2 

Position adjustments.

CONTRAST/BRIGHT---Used as a reference for Brightness and Contrast for the

X,Y Registration Menu
The X,Y Registration Menu is accessed (on the Tethered Remote Control) by

Registration, Sensitivity, of Threshold. Then press the MENU button to access the
menu. In the X,Y Registration Mode, the MENU button displays the X,Y

displays the Shade Menu. On a computer terminal, press D for Data, and then
press V to cycle through the X,Y Registration, Sensitivity, or Threshold Mode.

OFFSET THIS AXIS---This function adjusts all points on screen equally by
setting an offset for XY Registration. It may also be used as a fine adjustment

CLEAR THIS AXIS--- This function resets X- Y-axis to the default values for the
active color.

values for the active channel.

CLEAR ALL AXES--- This function resets ALL data to the default value for the

SEE X AXIS VALUES--- This function enables the user to see the X-axis values
in each cell when the projector is connected to a VT-100 terminal using a

® with 40 or more lines of display.

Shade Axes Menu
OFFSET THIS AXIS--- This function adjusts all points on the screen equally by

CLEAR THIS AXIS--- This function resets axis for the active color.

CLEAR SHADE AXES--- This function resets all shading data (Sensitivity and
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PROPTN THIS AXIS--- This function enables the user to offset (adust up or
down) all cells in one axis (color) in proportion to their individual values.

INIT THIS AXIS--- This function resets current mode for current color to 230
default.

INIT ALL AXES--- This function Resets Sens/Thres for all colors to 230 default
level. Must be done when starting up with new System Cont Board or updating
software.

SEE AXIS VALUES--- This function Enables operator to see Sensitivity or
Threshold axis values in each cell when projector is connected to a VT-100
terminal using a program such as Procomm Plus® with 40 or more lines of
display.

2.5 Autoselect
The Autoselect feature automatically selects a channel to match an incoming
source when the incoming source changes. Channels are assigned by the operator
to numbered Autoselect groups. When a source changes, the channels within the
same Autoselect group are searched without operator knowledge or intervention.
When a channel that matches the new source's parameters is found, that channel is
switched to automatically.

Need for Autoselect:
When the projector is operating in one channel and the incoming source changes,
the current channel may not be set up to properly process the new source. The
operator then must choose which channel is best suited to handle the new source,
and change to that channel with the remote. The operator may not know which
channel best matches the new source and a delay occurs in switching channels.

A similar situation exists when a switcher without RS-232 capability to control
projector switching is connected to one of the projector inputs. This switcher can't
send out a command to change projector channels when the switcher channel is
changed. The projector channel must be changed manually by the operator to the
correct channel for the new switcher channel. Again, the operator must know
which channel to switch to.

The Autoselect feature eliminates operator delays and confusion by automatically
switching to the correct channel within an Autoselect group.

Autoselect setup example
A computer, capable of selecting between different scan rates, is being used as a
source. Normally when the scan rate changes the operator manually changes
channels to one that is set up properly for the new source. Because the computer
provides sources at three different scan rates, the operator must change channels
each time the source changes.

For example, a computer provides the following three sources set up as indicated:
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q 

q 

q 

NOTE: 
and B).

To place three sources in an Autoselect group:

 From the CHANNEL MENU, select AUTOSELECT LIST.

Display Description
Global on/off state

GROUP 1-10
groups

CHANNELS 1-10
to 10 channels per group

N/A

2. 
3. 

to highlight the current state and press ENTER to select.

4. Use the UP/DOWN arrow keys to change the choice to OFF.

5. Press ENTER to save that state.

6. Use the UP/DOWN keys to highlight the group field.

7. Press ENTER to select.

8. Use the UP/DOWN keys to choose a group number.

9. Press ENTER to save that group number.

10. Press the right arrow key to highlight the group name field.

11. Press ENTER to highlight the first character, then scroll with the
UP/DOWN keys and press ENTER to select the first letter for the group

name. NOTE: The group name is for convenience only and may be omitted
if desired.

 Move the highlight to the first channel field in the list and press ENTER.

 Use the arrow keys and select Channel 1. Press ENTER to add Channel 1

NOTE 1: A channel can be in one Autoselect group only. To move a

to N/A.
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NOTE 2: The order of channel assignment is not important. The
Autoselect feature starts at the current channel when looking for a match
and scans down the list and back to the beginning of the list. The first
channel to match the incoming source is automatically selected.

14. Repeat Step 13 to add Channel 7 and 11 to Group 1.

15. Channels 1, 7, and 11, from the example, are now in AutoSelect Group #1.
More channels can be added to this group, if needed. Other channels can be
assigned to other groups as needed. One group can be for SUN
workstations with different scan rates, and one for MACs, etc. Do not
assign sources with very similar parameters to the same group (see
Autoselect limitations below).

16. When finished adding channels to Autoselect groups, turn the Autoselect
feature to ON as follows:

q Select CHANNEL LIST from the MAIN MENU.

q Select AUTOSELECT LIST from the CHANNEL LIST.

q Use the arrow keys and highlight AUTOSEL STATE ON/OFF. Press
ENTER to select it.

q Select AUTOSEL STATE ON. Press ENTER to lock the Autoselect
to ON.

Now, when the projector operates in one of the channels in Group # 1, and the
incoming source changes to one of the other two, the projector automatically
switches to the correct channel without any operator knowledge or intervention,
just as though the operator selected the channel manually.

Also, when the operator selects a channel within a group and the incoming video
doesn't match the selected channel's parameters, that group's channels are searched
for a match to the incoming source. The channel that most closely matches is
automatically switched to without any operator knowledge or intervention.

Autoselect Features And Limitations

Similar Sources
 Autoselect cannot switch between two channels with very similar horizontal
frequencies, vertical frequencies, and interlace modes. This occurs with Line-
Doubled NTSC Video and VGA 480 Computer Graphics, and with PAL and
SECAM video. If two sources with very similar video formats (within the
deadband—see below) are located in the same group number, Autoselect switches
to the source listed first on the Autoselect channel list. Sources with very similar
video formats should be placed in different Autoselect groups.

Deadband (Sensitivity)
 The deadband for distinguishing between different video formats is 20 horizontal
lines and 3 Hz vertical frames.
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Adding/Deleting Channels
 To add a channel to any Autoselect group, the video source must be connected
and active. The Autoselect feature must be OFF to add or delete a channel.

Autoselect OFF
 If Autoselect is OFF the projector will not automatically switch to another
channel.

Unmatched Incoming Sources
 If the operator switches to an incoming source that does not match any channel in
the Autoselect group, no autoselect switching occurs. The projecto remains on the
current channel.

Maximum Channels and Groups
 Up to 10 channels can be assigned to each group and there can be up to 10
groups, but there can only be a total of 30 group/channel combinations. Other
channels can exist that are not assigned to any Autoselect group but the total
number of channels cannot exceed 30.

Identical Autoselect Groups
It may be useful to have two groups with identical basic parameters. This is
feasible in situations where viewing will be in two different environments such as
daytime and nighttime or light and dark rooms. One Autoselect group can have
higher Brightness or Contrast than another group but otherwise be the same. The
operator can switch between the two groups and retain the same Autoselecting
between channels but for two different environmental situations. This saves the
operator from having to adjust Brightness or Contrast every time the environment
changes.

Channels not in Autoselect Groups
 These channels are not included when Autoselect searches for matching channels.

2.6 Importing and Exporting Data
Importing and Exporting setup data is a frontline defence against losing the
channel setup data such as X,Y Registration, Convergence, Geometry, and
Shading. It takes about 10 to 15 minutes to download (Export) this data. Compare

channels, which may take hours.

Importing and Exporting functions can not be performed using the Tethered

software. Microsoft® ® operating system, a
® 3.1) and Hyper Terminal

® 95/98). The Terminal program under Windows  3.1 works very well
however Hyper Terminal under Windows® 95/98 is a little tricky to use.

® or ProComm Plus  is
recommended as an alternative.
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  CAUTION!  It is very strongly recommended that setup

power supplies and backup batteries. Exporting baseline source setup

setting up new source file(s) in the case of an unexpected problem

VT-100 Terminal Control

the projector.  The VT-100 is connected to TERMINAL-IN (RS-232 #1).

While the ILA-12K projector was designed using the VT-100 terminal, any

with a PC to control the projector.  This document includes the procedures to set
®

®

Hardware/Software Requirements
..........................

COM2

......... ®
®

Windows  HyperTerminal.

................................ Female DB9 connector (to projector) to

wired as RS-232 Null Modem

Software ...........

Windows  3.1 Setup (Vt-100 Emulation)
®

®

Software is accomplished as follows:

 ®

2. From the menu bar, select SETTINGS.  From the SETTINGS menu, select

 
already selected).
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Terminal Preferences
4. Select SETTINGS again from the menu bar.

5. Select Terminal Preferences.

6. Set the following Modes:

Line Wrap: Yes CR → CR/LF

Local Echo: No Inbound: No

Sound:  Yes Outbound: No

Columns Cursor

80: Yes Block: Yes

132: No Underline: No

Blink: Yes

Terminal Font  Courier 12 Translations NONE

  IBM to ANSI No

Show Scroll Bars Yes  Buffer Lines: 100

Use Function Arrow, and
Ctrl Keys for Windows® No

Communications Protocol
1. Select Settings using the menu bar, then select Communications.

2. Set the following communications parameters and modes:

Baud Rate 9600 Stop Bits 1

Data Bits 8 Flow Control Xon/Xoff

Parity    None Carrier Detect No

Parity Check No

Connector: Com1 (This is PC configuration dependent)

3. Select File from the menu bar and select New.  Under File Name enter VT-

4. 100.TRM.  This will allow the user to select the file VT-100.TRM with the
above parameters saved for ease in future use.

Windows® 95/98 and ProComm Plus® Setup (VT100
Emulation)

Windows® 95/98 Hyper Terminal
Hyper Terminal has a few things that may cause confusion while uploading data
and for this reason ProComm Plus® communication software is recommended for
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Terminal Emulation, however, if the ProComm Plus® software is not available
Windows® Hyper Terminal will work.

To use Windows® Hyper Terminal:

1. With Windows® Operating System software running, Click on the START
button on the Taskbar. Go to the ACCESSORIES  submenu and select
COMMUNICATIONS.

2. In the COMMUNICATIONS subdirectory, select Hyper Terminal.

3. Hyper Terminal will automatically bring up a New Connection dialog box
that prompts for a name and icon to represent the new connection. Enter a
name, select an icon and click on OK.

4. Access the File Menu and Select PROPERTIES. This will bring up the
Properties dialog box shown in Figure 2-5. Select the “Connect To” Tab.

Figure 2-5  Properties dialog box.

5. In the “Connect using” box select an appropriate port. The correct
selection will depend on the configuration of the particular computer being
used.

6. Click the Configure… box. This will bring up the Port Setting dialog box.
Enter the settings shown in Figure 2-6.
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7. Hyper Terminal is now configured correctly to communicate with the
projector. Access the File Menu and select the Save as.. and give the file a
name.

Figure 2-6 Port Settings for Hyper Terminal in Windows® 95/98

ProComm Plus®

The parameters format shown in this procedure duplicate the format in the
ProComm Plus® software displayed on the monitor.  VT-100 emulation with the
PC using ProComm Plus® software is accomplished as follows:

1. In ProComm Plus® press ALT+Z to display COMMAND MENU.

2. Strike ALT+S to display SETUP UTILITY.

3. Select Terminal Options and set the following modes:

A- Terminal emulation VT100
B- Duplex FULL
C- Soft flow ctrl (XON/XOFF) ON
D- Hard flow ctrl (RTS/CTS) OFF
E- Line Wrap ON
F- Screen scroll ON



Chapter 2---Operation

2-24  ILA-12K User’s Manual

G- CR Translation CR
H- RS Translation DESTRUCTIVE
I -  Break length (msecs) 350
J - Enquire (ENQ) OFF
K- EGA/VGA true underline OFF
L- Terminal width 80
M- ANSI 7 or 8 bit commands 8 BIT

4. Strike ALT+D to display the DIALING DIRECTORY.

5. Setup next available entry in the directory; strike A (Add Entry):

Name: VT-100 Terminal
Number:
Baud: 9600
Parity: None
Data Bits: 8
Stop Bits: 1
Duplex: Full
PORT: COM1 (NOTE: PC Configuration

dependent)
Script:
Protocol:  ASCII
Terminal: VT100
Mode: direct
Password:
Meta file:
Kbd file:
Note file:

Export Channel Data to a PC using Windows® 3.1.
The following describes the procedural sequence for exporting ILA-12K channel
data to a PC (and disc).

1. Connect VT-100 Terminal or PC (set up to emulate the VT-100) to RS-
232 #1 port (TERMINAL-IN) using the RS-232 Null Modem Cable.

2. Start VT-100 terminal emulation from the PC. Select File from the menu
bar and select Open.  Use filename VT-100 TRM.

NOTE 1  The PC will now act as a controller to the projector and all
commands are now keyboard characters.  A menu list outside the
rectangular box will appear on the monitor screen.

NOTE 2  The Software will timeout in 10 seconds if actions are not
complete.

3. Select an active Projector channel from the channel list to be exported.
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4. To export channel data to the PC, select CHANNEL MENU from the
MAIN MENU and select EXPORT CHAN, DATA.  Enter channel number
to be exported when the Projector displays the message: ENTER
CHANNEL #.

5. The projector will display the message: PREPARE HOST TO RECEIVE
DATA. ENTER TO START ESC TO ABORT.

6. At the PC, select Transfers from the main menu bar and select Receive
Text File.  Enter the name of the channel to save, i.e., CH2.TXT. Strike the
Enter key twice to begin Transfer. Transfer is in progress when ASCII data
scrolls across the PC's screen.

7. The Projector displays the message: TRANSFERRING ESC TO ABORT.

8. Terminate transfer when the Projector displays the following message:
TRANSFER COMPLETE WHEN TERMINAL READY FOR NORMAL
OPERATION.  PRESS ANY KEY.  At the PC select Transfers from the
menu bar and select stop.

Import Channel Data from a PC Using Windows® 3.1
The following describes the procedural sequence for importing channel data from a
PC (or disc) to the ILA-12K projector.

1. Select an active Projector channel from the channel list.

2. To import channel data to the Projector, select CHANNEL MENU from
the MAIN MENU and select IMPORT CHAN. DATA (projector
automatically switches to internal sync. Enter channel number to be
imported when the Projector displays the message ENTER CHANNEL #.

NOTE: Import Data cannot be performed to the current active channel.

3. The projector will display the following message: READY TO RECEIVE
BEGIN UPLOAD NOW ESC TO ABORT.

4. At the PC, select Transfers from the menu bar and select Send Text File.
Select the drive letter where the floppy disc is located. Select the file name
of the channel to send. Press Enter to begin Transfer.

5. The PC will display send rate at bottom of screen and the message:
SENDING CHAN#. TXT.

6. Terminate transfer when the Projector displays the following message:
TRANSFER COMPLETE CHANNEL BANK XFER SUCCESSFUL
PRESS ESC.  Strike the ESC key to terminate transfer.

Export Channel Data to a PC using Windows® 95/98 Hyper
Terminal or ProComm Plus® Communications Software.
The following is the procedure for exporting ILA-12K channel data to a computer
(and disc). Two software programs can be used to emulate the VT-100 Terminal:
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ProComm Plus® communication software and Windows® Hyper Terminal. Both
programs work adequately however, ProComm Plus® is the preferred software for
to ease of use.

ProComm Plus®

1. With Windows® 95/98 Operating System software running, start the
ProComm Plus® software.

2. In ProComm Plus® access the File Menu and select OPEN.  Locate the file
that is configured for a VT-100 Terminal. Press ENTER.

NOTE 1: The PC will now act as a controller to the Projector and all
commands are now keyboard characters.  A menu list outside of the
rectangle box will appear on the PC's screen.

NOTE 2: The Software will time-out in 10 seconds if actions are not
completed

3. Select an active Projector channel from the channel list to be exported.
From the MAIN MENU select the STATUS MENU and set projector to
internal sync by toggling 5.

4. To Export channel data to the computer, select CHANNEL MENU from
the MAIN MENU and select IMPORT/EXPORT.  Enter channel number
to be exported when the Projector displays the message: ENTER
CHANNEL#.

5. The Projector will display the message:

PREPARE HOST TO RECEIVE..
<ENTER> TO START
<ESC>TO ABORT.

6. In ProComm Plus®, access the Data Menu and select Receive Text File.
Give the file a name (the name of the channel to save, i.e.; CH2.TXT).
Press the Enter key twice to begin transfer.

7. Transfer is in progress when ASCII data scrolls across the computer
screen. The Projector displays the message:

TRANSFERRING
ESC TO ABORT.

8. Terminate transfer when the Projector displays the following message:

TRANSFER COMPLETE WHEN TERMINAL READY FOR
NORMAL OPERATION.
PRESS ANY KEY.

9. At the computer strike the ESC key twice.
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Windows® Hyper Terminal
1. Connect the RS-232 null modem cable from the PC serial comm. port

connector to the projector RS-232 port #1 (TERMINAL-IN) connector.

2. With Windows® 95/98 Operating System software running, Click on the
START button on the Taskbar. Go to the ACCESSORIES  submenu and
select COMMUNICATIONS.

3. In the COMMUNICATIONS subdirectory, select Hyper Terminal.

4. In the Windows® Hyper Terminal, select the File Menu and select OPEN.
Find the VT-100 Terminal file (named in step 7 of the Windows® 95/98
VT-100 Emulation setup for Hyper Terminal).

5. Press Ctrl + P to power ON the projector. To perform the EXPORT
function, the projector (or at least the Electronics (Ctrl+E toggles the
Electronics ON and OFF)) must be powered ON.

6. Press the SPACEBAR to bring up the MAIN MENU.

7. From the MAIN MENU, select item #1 CHANNEL MENU.

8. Fom CHANNEL MENU, select either EXPORT A CHANNEL or
EXPORT MULT CHNLS.

9. The screen will display:

CHANNEL NUMBER?
Enter a channel or multiple channels and press ENTER.

10. The screen will display:

PREPARE HOST TO RECEIVE DATA.
<ENTER> TO START
<ESC> TO ABORT

11. Access the Hyper Terminal TRANSFER MENU and select CAPTURE
TEXT. The channel setup data will be exported as a text file.

12. Select a path and give the file a name such as the projector serial number
i.e, 34114.txt. Make sure to add the txt extension on the file name to create
a text file.

13. Press ENTER to confirm the file name. Press ENTER again to begin the
download (Exported). Hyper Terminal will begin downloading data.

14. After the channel(s) have been downloaded, the program will display:

STOP YOUR DOWNLOAD NOW, THEN PRESS A
KEY FOR MENU!!!

15. In Hyper Terminal, access the TRANSFER MENU, and select CAPTURE
TEXT, and from the submenu, select STOP and press any key to return to
the projector menu.
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16. The Export process is complete.

Import Channel Data From A PC Using Windows® 95/98
Hyper Terminal or Procomm Plus® Communications
Software
The following is the procedure for importing channel data from a PC (and disc) to
the ILA-12K projector.

ProComm Plus®

1. Select an empty projector channel from the CHANNEL LIST.  From the
MAIN MENU select the STATUS MENU and set projector to internal
sync by toggling 5.

2. To import channel data to the Projector, select CHANNEL MENU from
the MAIN MENU and select item #6 IMPORT/EXPORT.

3. Select either IMPORT A SINGLE CHANNEL or IMPORT MULT
CHNLS. Enter channel number(s) to be imported when the projector
displays the message:  ENTER CHANNEL #.

NOTE:  Import Data cannot be performed to the current active channel.

4. The projector will display the following message:

READY TO RECEIVE..
BEGIN UPLOAD NOW..
<ESC> TO ABORT.

5. In ProComm Plus® access the Data Menu and select the SEND DATA

6. The PC will display send rate at bottom of screen and the message:
UPLOAD IN PROGRESS....

7. Terminate transfer when the Projector displays the following message:
TRANSFER COMPLETE CHANNEL/BLANK XFER SUCCESSFUL
PRESS ESC.  Strike the ESC key to terminate transfer.

Windows® Hyper Terminal
1. Connect the RS-232 null modem cable from the PC serial comm. port

connector to the projector RS-232 port #1 (TERMINAL-IN) connector.

2. With Windows® 95/98 Operating System software running, Click on the
START button on the Taskbar. Go to the ACCESSORIES  submenu and
select COMMUNICATIONS.

3. In the COMMUNICATIONS subdirectory, select Hyper Terminal.

4. In the Windows® Hyper Terminal, press Ctrl + P to power ON the
projector. To perform the EXPORT function, the projector (or at least the
Electronics (Ctrl+E toggles the Electronics ON and OFF)) must be
powered ON.
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5. Press the SPACEBAR to bring up the MAIN MENU.

6. From the MAIN MENU, select item #1 CHANNEL MENU.

7. Fom CHANNEL MENU, select either IMPORT A CHANNEL or
IMPORT MULT CHNLS.

8. The screen will display:

TARGET CHANNEL?
Enter the number of any empty channel or multiple channels (check the
CHANNELS LIST) and press ENTER.

9. The screen will display:

READY TO RECEIVE..
BEGIN UPLOAD..
<ESC> TO ABORT

10. Access the Hyper Terminal TRANSFER MENU and select SEND TEXT
FILE. The channel setup data will be exported as a text file.

11. Locate and select the file or files to be uploaded (Imported)

12. Press ENTER to confirm the file name. Press ENTER again to begin the
download (Imported).

13. At this point the setup data begins to upload to the projector. PLEASE
READ THE FOLLOWING NOTE BEFORE DOING ANYTHING
ELSE!!

NOTE: The problem with the Hyper Terminal program is that the user
would expect it to give some indication that the uploading process is
happening, but it does not. The screen still displays the READY TO
RECEIVE DATA. The important thing to know is that the program IS
UPLOADING DATA AT THIS TIME. If any keys are pressed during the
uploading process the Hyper Terminal program will most likely lock up.
DO NOT TRY TO RESTART THE UPLOAD PROCESS OR PRESS
ANY KEYS. Hyper Terminal takes about 24-30 seconds to upload a
channel. Allow sufficient time for each channel to upload.

14. After the channel(s) have uploaded into the projector, the screen displays:

TRANSFER COMPLETE
PRESS ESCAPE

15. Press the ESC key to return to the IMPORT/EXPORT MENU.

16. The Import process is complete.


